
VirusDetective® Help
Options Dialog Box

The VirusDetective Options dialog box could easily be considered the “Preferences” dialog box. The 
Options dialog box gives you quite a bit of choice in regard to under what circumstances you want log 
files created, what file format you want word processing files saved as, and other selections.

Before you read this Help file – if you have not done so already, be sure to read the two definitions at 
beginning of the Main Window Help file.

TABLE OF CONTENTS…
A)    Log File Options… Buttons and Checkbox;
B)    Create Log File… Buttons;
C)    Save Files in the Form of… Buttons;
D)    “Can’t Cancel VB Scan”, “Unattended Operation”, and“ No Error Msgs.” (Three Miscellaneous 
Checkboxes);
E)    Options Help File (in the Scrollable Window);
F)    “Help->Clipboard”, “Cancel” and “Save” Buttons.
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A)    LOG FILE OPTIONS… BUTTONS AND “WRITE FILE/RESOURCE INFORMATION TO LOG FILE” 
CHECKBOX…
In the Log File Options section, you have three choices: No Log, Log All Files, or Log Only Matched Files.
Log files are only created for VirusDetective - initiated scans and NOT for automatic scans requested by 
VirusBlockade II.

A.1.1    “No Log” button…
When you click the No Log button, VirusDetective keeps no record of what it scans. 

A.1.2    “Log All Files” button…
When you click the Log All Files button, VirusDetective writes an entry for each file it scans, including files
that are not infected.

A.1.3    “Log Only Matched Files” button…
When you click Log Only Matched Files, VirusDetective writes an entry only for files it scans that match a 
search string (that is, for files that are infected). VirusDetective doesn’t write information to the log file 
regarding ALL files, only matched files.

A.2    Write File/Resource Information to Log File checkbox…
When you click the Write File/Resource Information to Log File checkbox, when VirusDetective finds an 
HTD, this checkbox adds the file/resource information to the log file (this information is the same as the 
Main Window’s Show Info button). If No Log is selected, the Write File/Resource Information to Log File 
checkbox is inactive. 
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B)    CREATE LOG FILE… BUTTONS…
You can create a log file in one of two ways, in the form of: One Master File or Separately for Each Disk. 



When you click One Master File button, you get one long log file where all disk logs are consolidated into 
this one log file. Each individual disk’s log file gets added to the end of the last disk’s log file. The master 
log file closes when you close VirusDetective. This is significant because until VirusDetective closes the 
file, no word processing application can open it.

When you click Separately for Each Disk, you get a separate log file for each individual disk.
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C)    SAVE FILES IN THE FORM OF… BUTTONS…
The Save Files in the Form of… section controls what word processing text file format VirusDetective 
writes. The text file format affects two entirely different categories of files: 1) log files, and 2) search string 
files; that is, the text file format pertains to BOTH log files and search string files. You have six choices (if 
you don’t like the first five choices, there is a sixth choice that includes all other text file formats), as 
follows: 

a) MacWrite; b) MacWrite II; c) TeachText; d) WriteNow; e) Microsoft Word; and lastly, f) the 4-character 
Creator ID code, the ‘catch-all’ sixth choice. 

VirusDetective saves each file (log files and search string files) as a text file. If you save in MacWrite, it 
saves it as a MacWrite text file; if you save in WriteNow, it saves it as a WriteNow text file; if you save in 
Word, it saves it as a Word text file, etc.

Know that a text file can be opened by any other Macintosh word processing application from WITHIN the
word processing application itself. How you open the file from WITHIN the application is first run your 
preferred word processing application, select Open from the File Menu (or if that doesn’t work, try Import),
locate and then open the desired text file. If you open file from within a word processing application, you 
can have VirusDetective save files in any text format.

If you want to be able to open the text file by double-clicking on the text file’s icon, you can do it one of 
two ways. The first way is, if your preferred word processing application is MacWrite, MacWrite II, 
TeachText, WriteNow, or Microsoft Word, select the button for it; or…

The second way is select the sixth button: the XXXX (4-character Creator) ID code. Below are some 
popular word processing application 4-character Creator ID codes that you can input. Type it exactly as 
you see it (don’t type the single quotes). If the ID code has a space, type the space. It DOES matter 
whether you type uppercase and lowercase:

                    FullWrite Professional                                        'FWRT'
                    MindWrite by Delta Point                              'PWRI'
                    MPW by Apple                                                                        'MPS'
                    Nisus by Paragon Concepts                'NISI'
                    Taste by Delta Point                                                    'tAst'
                    WordMaker by New Horizons              'WMkr'      <---this ID code could cause WillMaker to run 
instead.
                    WordPerfect                                                                                  'SSIW'
                    Works by Microsoft                                                        'PSI2'
                    Write by Microsoft                                                            'MSWT'
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D) “CAN’T CANCEL VB SCAN”, “UNATTENDED OPERATION”, AND “IGNORE ERROR” (THREE 



MISCELLANEOUS CHECKBOXES)…

D.1    “Can’t Cancel VB Scan” checkbox…
When VirusDetective is open and is the active window, you normally can stop a scan in progress by 
clicking the Cancel button or typing Command-<period> or the Esc (Escape) key.

However, when VirusBlockade tells VirusDetective to do an automatic, “invisible” scan (since 
VirusDetective is not open and not the active window), there is no button to click to cancel the scan – 
however, you still can cancel a scan by typing Command-<period> or Esc from the keyboard.

There will be more than one occasion (for example, regarding a public Macintosh) when you ALWAYS 
want the user to be forced to complete an automatic, “invisible”, VirusBlockade-controlled scan and you 
definitely don’t want the user to be able to cancel the scan (by using Command-<period>, Esc, or any 
other means); this is where the Can’t Cancel VB Scan checkbox fits in. When you click the Can’t Cancel 
VB Scan checkbox, you disable the ability of the Macintosh user to cancel the VirusBlockade-controlled 
scan – (s)he can NO LONGER use Command-<period> or Esc to cancel a scan. 

                   NOTE: When you click the Can’t Cancel VB Scan checkbox, you can still use the Cancel button,
Command-<period> and Esc to cancel a scan that VirusDetective originated while VirusDetective was 
open.

D.2    “Unattended Operation” checkbox…
Normally when VirusDetective is the active window and it finds an HTD, VirusDetective will pause and 
wait for you to respond. If you click the Unattended Operation checkbox, it will NOT pause and wait for 
your response.

Checking the Unattended Operation checkbox automatically checks the No Error Msgs. checkbox since 
you probably don’t want any error messages either. The checkmark in the No Error Msgs. checkbox is by 
any means permanent – you can uncheck the No Error Msgs. checkbox anytime.

If you have clicked VirusDetective’s Unattended Operation checkbox, and are using VirusBlockade II 2.x, 
click VirusBlockade’s Unattended Operation checkbox as well. If one is ON, the other should be ON; if 
one is OFF, the other should be OFF. They go together as a team.

                            NOTE: WHEN RUNNING IN “UNATTENDED OPERATION”, INFORMATION IS LOST 
UNLESS YOU HAVE VIRUSDETECTIVE CREATE A WRITTEN LOG FILE. WE HIGHLY RECOMMEND 
YOU KEEP A WRITTEN LOG!

D.3 “No Error Msgs.” checkbox…
When you click the No Error Msgs. checkbox, it prevents VirusDetective from displaying error messages. 
If you get frequent error messages, and do not want to see them, click No Error Msgs.. You should first 
investigate the cause(s) of frequent errors before you ignore the messages. No Error Msgs. doesn’t mean
VirusDetective disregards the error but just doesn’t display any error messages.

Normally when VirusDetective detects an error in a file that VirusDetective is about to scan, 
VirusDetective won’t scan that particular file and does alert the user that it found an error. With this option 
selected, VirusDetective skips the file, and does NOT alert the user.

When VirusBlockade orders VirusDetective to scan a floppy disk, VirusDetective ejects the floppy disk 
when VirusDetective finds an error (as it does when an HTD is detected).

                            NOTE: When VirusDetective displays an error message, ALL applications stop until you 
click “OK”. If you are operating VirusDetective on an unattended Macintosh (as would be the case on a 



FILE SERVER), it probably would be a good idea to click the “No Error Msgs.” checkbox.

                            ANOTHER NOTE: The “No Error Msgs.” checkbox should be used SPARINGLY! Some 
errors will cause other applications problems when using that file. You probably want to know about what 
files contain certain problems.

One of the possible error messages is:

                            VirusDetective® encountered error(s) scanning because a resource fork is either: 1) corrupt
(damaged), or 2) faulty (incorrect). <Gives file name.>

D.3.1    The above error message covers these three reasons…

D.3.1.1    A file’s resource fork is corrupt (damaged)…
Before VirusDetective scans a file’s resource fork, it performs an integrity check to make sure the 
resource fork is not damaged.

If this integrity check fails,VirusDetective displays this error message which is highly useful to you. If the 
reason you got the error message is because the file’s resource fork is corrupt, it is important you get this 
message and thereby prevent other applications from crashing when reading this file.

D.3.1.2    A file’s resource fork is faulty…
When we say “faulty”, we mean “not right”, “incorrect” or “incomplete” at the time VirusDetective tried to 
scan a file’s resource fork. A file’s resource fork could be “not right” for a couple of reasons:

D.3.1.2.a    The first is when VirusDetective tries to scan a file when the file’s resource fork was in the 
middle of being written; these simultaneous events most often happen on two occasions: 1) when 
VirusBlockade orders VirusDetective to scan a file that is in the middle of being uncompressed (such as 
with DiskDoubler or StuffIt), or 2) when VirusDetective scans a file that is in the middle of being receiving 
from a remote host (“downloaded”).

D.3.1.2.b    <NOTE: THIS SITUATION IS RARE>  The second is when the developers, in programming a 
given application, created the application such that the application, on a regular basis, generates files 
which have non-standard (“bad”) resource forks. Non-standard resource forks usually occur when the 
developers refuse to follow development standards set forth by Apple (either consciously or because of 
ignorance). Files with non-standard resource forks normally work fine with the application it was designed 
to work with, but does not necessarily coordinate well with other programs. 

D.3.2    How to diagnose which of the three reasons is causing VirusDetective to display this error 
message…
You get the very same error message for all three aforementioned reasons (it has to be this way; the 
Macintosh has no way to distinguish between them. All the Macintosh knows is that something is wrong, 
but it can’t say what.

The first step in diagnosis is open VirusDetective and have it re-scan the questionable file. If you don’t get
the error message any longer, everything is fine. 

After VirusDetective re-scans this second time, if you don’t get the error message any longer AND you 
know you have been uncompressing or downloading files, it was probably because VirusDetective tried to
scan in the middle of the file being written – there is no cause for alarm. It is VirusDetective’s way of 
telling you that VirusDetective tried to scan when a file was getting written-to-disk. (NOTE: Creating a 
data fork was what probably triggered VirusDetective to scan the file in the first place).



After VirusDetective re-scans the file the second time, if you STILL get the error message, the file is likely 
to be one of two things: 1) the file is corrupt, or 2) the developers wrote an application which generates 
files that do not follow Apple’s standardization guidelines. Since the latter is rare, chances are very good 
that that individual file is actually corrupt.

Assuming you wish to continue the diagnosis process, the second step, if you can retrieve a “clean” 
version of the file from the original disk or a backup, do so. If you STILL get the error message on a 
supposedly perfect version of the file, it likely means the developer or distributor of the application has 
done something incorrectly. It could be that the developer or distributor sent you a corrupt file; have the 
developer or distributor send you another supposedly “clean” version of the file you require. 

The third and last step, if you get the error message EACH AND EVERY TIME VirusDetective scans any 
and all files generated by a particular application (including the “clean” file they just sent you), yet you 
don’t seem to get many error messages with files generated by other applications, DO suspect the 
application’s developers created the application such that it generates non-standard resource forks. You 
should contact the developer or distributor to have them rectify the situation.
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E)    OPTIONS HELP FILE (IN THE SCROLLABLE WINDOW)…
<You are in this file now.> Scroll up or down to find the information you require.
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F)    “HELP->CLIPBOARD”, “CANCEL”, AND “SAVE” BUTTONS…

F.1    “Help->Clipboard” button…
When you click the Help->Clipboard button, you can copy the contents of the Help file to the Clipboard. 
Paste the contents of the Clipboard to wherever you want (which very well could be your favorite word 
processing application).

F.2    “Cancel” button…
When you click the Cancel button: 
                    1) if you made any changes, VirusDetective presents an alert box that asks “Save changes to 
name of the dialog box?”. You have the choice between: Don’t Save, Cancel (this cancel cancels the first 
cancel) or Save;
                    2) if you didn’t make any changes, VirusDetective brings you back to the Main Window.

F.3    “Save” button…
If you click the Save button, VirusDetective saves any changes and then closes the dialog box.
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